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1.  TIMSS 2003 Electronic Codebook 

The Electronic Codebook (ECB) software tool enables analysts to review and extract United 
States TIMSS 2003 data.  With this ECB software tool, an analyst can perform the following 
actions: 
 

• Search the names and labels of variables in the TIMSS 2003 national data file catalog; 
 

• Examine the unweighted response categories, frequencies, and percentages of responses 
for one or more catalog variables;  

 
• Create a list of variables to be extracted from the catalog (taglist), save the list for later 

use, recall a previously saved taglist,  print the list as a codebook, or taglist; and 
 

• Automatically generate SAS and SPSS programs to extract selected variables from the 
whole data set or for a subset of defined cases. 

 
The ECB software tool only works on personal computers running a Windows-based 
environment (Windows 95 or higher).  It will not run with other computer operating systems, 
such as Macintosh and Linux.  The ECB software tool is included on this CD-ROM along with 
the national data files (in ASCII format) and the TIMSS 2003 Data Analysis User’s Guide.  
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2. TIMSS 2003 Electronic Codebook Tutorial 

 
 
2.1  Installation of Electronic Codebook, Data Files, and SAS and 

SPSS Macros 

The installation of the ECB has two parts: the ECB itself; and the raw data files.  The raw data 
files are in ASCII format and can be accessed independently of the ECB.  The disk space needed 
to install the ECB and raw data files varies according to what the user selects to install. For 
example:  

 
Full installation  23 MB Required 
Full installation of ECB  18 MB Required 
Full installation of data files and documentation  5 MB Required 

 
To install the ECB: 
 
1. Select DOWNLOAD DATA from the HOME window. 

2. Once in the DOWNLOAD DATA window, select GRADE 4 ELECTRONIC 
CODEBOOK or GRADE 8 ELECTRONIC CODEBOOK.  

3. InstallShield will automatically start. Follow all prompts from within 
InstallShield. 

4. Wait for the screen to display “Setup is Complete.” 

5. Click OK to end installation. 

6. The ECB is ready to run. 

The raw data files and programs may be accessed by selecting the DOWNLOAD DATA button 
from the HOME window. 

To install the raw data and programs: 
 
1. Select DOWNLOAD DATA from the HOME window. 

2. Once in the DOWNLOAD DATA window, select the GRADE 4 DATA 
FILES button or the GRADE 8 DATA FILES button. 

3. The data files are in a self-extracting zip file. The installation process prompts 
the user to unzip the data files to a directory. 

4. Enter a destination drive or accept the default drive and click UNZIP. 
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5. Wait for the screen to display dialog box indicating that the files have been 
successfully unzipped. 

6. Click OK to end installation, and then click CLOSE. 

7. The data files are installed. 

Note that the directories and subdirectories are created by the program. 
 

Also included are SAS and SPSS macro files to assist users in statistical analysis.  These macros 
are described in Chapter 5 of the User’s Guide on this CD.  They may be accessed by selecting 
the DOWNLOAD DATA button from the HOME window. 

To install the macro files: 
 
1. Select DOWNLOAD DATA from the HOME window. 

2. Once in the DOWNLOAD DATA window, select the SAS MACROS button or 
the SPSS MACROS button. 

3. The macros are in a self-extracting zip file. The installation process prompts the 
user to unzip the data files to a directory. 

4. Enter a destination drive or accept the default drive and click UNZIP. 

5. Wait for the screen to display dialog box indicating that the files have been 
successfully unzipped. 

6. Click OK to end installation, and then click CLOSE. 

7. The data files are installed. 

Note that the directories and subdirectories are created by the program. 
 
To create a shortcut, before closing the ECB folder move any or all icons onto the 

window by:  
 
1. Selecting any or all icons; 

2. Pressing the Control key; and 

3. Dragging the icon to the desktop using the mouse. 
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2.2   Reading the Quick Guide and User’s Guide 

The Quick Guide and User’s Guide are in Portable Document Format (PDF). The user will need 
Adobe Acrobat Reader to read this type of format. The program will check if you have Acrobat 
Reader available and will direct the user to load the program if it is not already installed on the 
machine. Users who have an older version of Acrobat Reader may install the latest version by 
selecting the ACROBAT READER button on the VIEW/DOWNLOAD REPORTS page. 

 
2.3   Downloading the Quick Guide and User’s Guide 

The user may download any of these files once they have been opened to view. To download any 
of these files, go to the File menu, select Save As from the drop-down list in the Acrobat Reader 
window menu, and save the document to any directory. 
 
 
2.4   Starting the ECB 

 
1. From the desktop, click on the Start button, select All Programs, and click on Electronic 

Codebook.  Double clicking on the Electronic Codebook icon on the desktop will also 
invoke the software. 

 
2. After the initial splash-screen appears, the Select Catalog dialog box will appear (Figure 1).  

Highlight the catalog (data file) to examine by clicking the desired catalog.  Click the OK 
button. 

 
 

 
Figure 1.  Select catalog dialog box 

 
3. The Main ECB screen now appears (Figure 2).  The Variable List comprises the left part of 

the screen, while the Working Taglist comprises the right part of the screen.  The Title Bar 
sits on top of the screen, while the Menu Bar sits underneath the Title Bar. 
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Figure 2.  Main ECB Screen 

 
 
2.5   Main ECB Screen 

 
The Variable List appears on the left half of the Main ECB screen.  It displays all variables for 
the catalog.  Besides the variable names, the list also displays a brief description of the variables.  
From the variable list, an analyst can view codebook information for a variable, narrow or expand 
the variable list, or tag variables for extraction. 
 
The Working Taglist appears on the right half of the Main ECB screen.  It displays a list of 
variables that are currently selected (tagged) for extraction.  The initial working taglist consists of 
a set of required variables for that catalog.  Analysts may alter the working taglist by adding and 
dropping variables from the variable list, but they may not drop (untag) required variables.  From 
the working taglist, an analyst can view codebook information for a tagged variable, delete 
variables from the taglist, use predefined taglists, view codebook information for a taglist, and 
save taglists. 
 
The Title Bar is the horizontal bar located at the top of the Main ECB screen.  Common to all 
Windows-based programs, it gives the name of the application. 
 
The Menu Bar lies underneath the title bar.  The bar contains a series of pull-down menus (File, 
Taglist, Extract, Tools, Codebook, and Help).  Selecting items from the pull-down menus provide 
access to the action commands available in the ECB. 
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To access the menus, follow these steps: 
 

1. Point to an item on the menu bar and click. 
 

2. Click on a command from the drop-down list. 
 
Keystrokes can also be used to access menu bar items.  All of the menus have one letter 
underlined; this letter is the hot key.   Pressing <ALT> and the underlined letter at the same time 
opens that menu.  Within the menu, use the arrow keys to move to menu items.  Press the up and 
down arrows to move to the desired command and press <ENTER>.  An item that appears in 
dimmed print is not available for the current screen. 
 
 
2.6   Variable List Functions 

 

2.6.1  Viewing Codebook Information for a Variable 

 
To view codebook information for a variable, follow these steps: 
 

1. Scroll through the variable list until the desired variable is found. 
 

2. Click on the variable name to highlight it.  The variable name is the only active field in the 
window.  No action will be taken by clicking on the variable description. 

 
3. Press <ENTER> or double-click on the highlighted variable name. 

 
4. The Variable Quick View window opens, containing the codebook information for the 

highlighted variable (Figure 3). 
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Figure 3. Variable Quick View 

 
Information displayed in Variable Quick View window include the variable name and label, any 
question number and wording associated with the variable, the record number, position, and 
format of the variable on the data file, and any comment fields.  The Variable Quick View 
window also displays values of discrete variables, ranges for continuous variables, unweighted 
frequencies, and unweighted percentage distributions. 
 

5. To close the Variable Quick View window, click on the X button in the upper right-hand 
corner of the window.  The Main ECB screen will reappear. 

 
 

2.6.2  Narrowing or Expanding the Variable List 

 
To narrow the list of variables to include only variables that contain a specific keyword, follow 
these steps: 
 

1. Click the Narrow button under the menu bar.  The Narrow Text dialog box will appear 
(Figure 4). 
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Figure 4. Narrow Text dialog box 

 
2. Type the keyword in the text box underneath “Enter Narrow Text.” 

 
3. Click the circle beside Variable Name, Variable Description, or Both Variable Name 

and Description to specify where to search for the keyword. 
 

4. Click the Search button. 
 
To add to the list of variables any catalog variables that contain a specific keyword, follow these 
steps: 
 

1. Click the Expand button under the menu bar.  The Expand Text dialog box will appear 
(Figure 5). 

 

 
Figure 5. Expand Text dialog box 

 
2. Type the keyword in the text box underneath “Enter Expand Text.” 
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3. Click the circle beside Variable Name, Variable Description, or Both Variable Name 
and Description to specify where to search for the keyword. 

 
 

4. Click the Search button. 
 
 
Because the initial variable list contains all variables for a catalog, selecting the Expand option is 
not necessary unless the original variable list has been narrowed.  Note that altering the variable 
list has no effect on the working taglist. 
 
Clicking the Reset button under the menu bar refreshes the variable list to show all catalog 
variables. 
 
If a keyword specified in the search to narrow or expand the variable list does not appear in any 
of the catalog variable name and/or descriptions, the No Matches Found message box will 
appear and the variable list will disappear from the screen (Figure 6).  Simply click the OK 
button, then the Reset button to retrieve all the catalog variables. 
 

 
Figure 6. No Matches Found message box 

 
 
 
2.7.    Creating a Taglist  

 

2.7.1  Adding Variables to a Taglist 

While browsing the variable list, a variable can be selected for a taglist in the following ways: 
 

1. To tag one or more variables, highlight the variables in the variable list.  Click the > button 
on the vertical bar that separates the variable list and working taglist. 

 
2. To tag all of the variables at one time, click the >> button.  A prompt will appear.  Click 

OK.  
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2.7.2  Deleting Variables from the Working Taglist 

A variable can be deleted (untagged) from the working taglist in the following ways: 
 

1. To untag one or more variables, highlight the variables in the working taglist.  Click the < 
button. 

 
Note that each catalog contains a set of required variables for extraction.  If one of these 
required variables is selected for deletion from the working taglist, the Required Variable 
message box will appear (Figure 7).  Click OK to clear the message box and return to the 
working taglist. 
 

 
Figure 7. Untag Variables message box 

 
2. To untag all of the non-required variables at one time, click the << button. 

 
 
 

2.7.3   User-defined taglists 

 
To aid analysts, one or more taglists may have been defined by the user for each catalog and 
saved for later use.  These taglists can be accessed from the Taglist menu on the menu bar.   
 
Select the Add command from the Taglist menu to expand the working taglist with additional 
variables from a user-defined taglist.  A dialog box containing all user-defined taglists associated 
with the catalog will appear.  Click on the desired taglist name, and press the OK button to start 
the merge the two taglists.  Additional taglists may be added, but they must be added one taglist 
at a time. 
 
Select the Open command from the Taglist menu to replace the current working taglist with a 
previous user-defined taglist.  A prompt to save the current working taglist will appear; see the 
Saving Taglists section for more information about saving taglists.  All previously tagged 
variables, except for the required variables, will disappear from the working taglist.  A dialog box 
containing all predefined and user-defined taglists associated with that catalog will appear.  Click 
on the desired taglist name, and press the OK button.  The variables from the highlighted taglist 
will appear in the working taglist. 
 
Select the New command from the Taglist menu to return the working taglist to its original state, 
eliminating all catalog variables except the required variables.  If the current working taglist has 
been modified, a prompt to save the current working taglist will appear; see the Saving Taglists 
section for more information about saving taglists. 
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Select the Delete command from the Taglist menu to remove any user-defined taglists.  A dialog 
box containing all user-defined taglists associated with that catalog will appear.  Click on the 
desired taglist name, and press the OK button to delete the list.  A message box will appear to 
verify permanent deletion of the taglist.  Press the Yes button to delete the taglist, or press the No 
button to keep the taglist.  If there are no user-defined taglists associated with the catalog, an error 
message box will appear.  Click OK to get rid of the message box.  Note that predefined taglists 
can not be deleted. 
 
 
 

2.7.4  Viewing Codebook Information for a Taglist 

 
To view a codebook for the current working taglist, follow these steps: 
 

1. Select the Codebook menu from the menu bar. 
 

2. Choose the View command from the menu.  A View Codebook screen will appear (Figure 
8). 

 
The View Codebook screen has a toolbar at the top.  Use the arrow icons on this toolbar to move 
through the codebook.  Click the right arrow to move to the next codebook page, click on the left 
arrow to move to the previous codebook page.  Click the arrow icons containing a vertical line to 
move either to the first page (left arrow) or last page (right arrow) of the codebook. 
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Figure 8.  View Codebook screen 

 
The numbers between the arrow buttons on the toolbar are page counters.  If a “+” follows the 
page number, there are more pages to be seen in the codebook.  On the last page of the codebook, 
the plus sign disappears, and the number of pages in the current codebook will be displayed.  The 
stop icon (the button with the black square on it) is active when loading tagged items for viewing 
codebook information, when paging through the codebook, and when exporting the codebook.  
The scroll bar at the far right of the screen allows you to scroll the current page of the codebook, 
but it does not scroll from page to page.  The arrow keys on the keyboard can also be used to 
scroll up or down the current page. 
 
Information displayed in the View Codebook screen includes the variable name and label, any 
question number and wording associated with the variable, the record number, position, and 
format of the variable on the data file, and any comments in the comment fields.  Like the 
Variable Quick View, the View Codebook screen also displays values of discrete variables, 
ranges for continuous variables, unweighted frequencies, and unweighted distributions.   
 
Icons for printing and exporting are also available on the menu bar, as is a drop-down box for 
zooming in and out of the codebook view.   
 
Click the Print icon (the button with the printer image) to send the displayed codebook to the 
default printer.  The Print dialog box then will appear.  Select the Print Range and number of 
Copies required, then click on the OK button to print the codebook. 
 
Click the Export icon (the button with the envelope image) to export the displayed codebook in a 
format that can be read by another software application.  The Export dialog box then will appear.  
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The codebook can be exported to one of the three format choices available on the screen.  
Selecting Crystal Reports saves the data in a format that can be opened in Crystal Reports.  The 
resulting file will have the extension *.rpt.  Rich Text Format saves all formatting and converts it 
to instructions that other programs, including Microsoft compatible programs, can read and 
interpret.  The resulting file will have the extension *.rtf.  Word for Windows saves the document 
as a Word document; the file created will have the extension *.doc. 
 
The only Destination option in the Export dialog box is to a disk file.  Possible locations for the 
disk file cover floppy disk drives, read/write CD-ROM drives, hard drives, and any networked 
drives connected to your computer during the ECB session. 
 
 

2.7.5  Saving Taglists 

 
To save a new taglist, follow these steps: 
 

1. Click on the Taglist menu from the menu bar, and then select the Save As command.  
 

2. A Save Taglist As dialog box will appear that lists the names of user-defined taglists 
associated with the catalog (Figure 9).  To replace a user-defined taglist with the current 
taglist, click on the name of the user defined taglist to be replaced.  To save the taglist to a 
new name, enter the name in the Taglist Name box. 

 

 
Figure 9. Save Taglist As dialog box 

 
3. Press the <ENTER> key or click Save to save the taglist with the new name. 

 
4. If a taglist with that name exists, a verification dialog box will appear (Figure 10).  Click the 

Yes button only for replacement of the old taglist with the new taglist.  Click the No button 
to keep the original taglist.   
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Figure 10.  Replace Existing Taglist dialog box 

 
To save changes to a user defined taglist currently residing in the working taglist, click on the 
Save button above the working taglist.  It will save the modified taglist under the original user 
defined taglist's name.  Clicking on the Taglist menu and selecting the Save command will 
accomplish the same task. 
 
 
 

2.7.6  Importing and Exporting Taglists 

 
The ECB is designed to save taglists to a default location but they may also be saved to a user-
specified location using the Export option under the Taglist menu.  To save a taglist to a specific 
location: 
 

1. Click on the Taglist menu from the menu bar, and then select the Export command.  
 

2. The Export Working Taglist To dialog box will next appear (Figure 11).  Specify the 
name for the taglist file.  The extension (*.tlt) will be added automatically.  If a different 
folder is desired, select one from the Save In drop-down menu.  A new folder can be created 
by clicking on the icon showing a folder with a star behind it. 
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Figure 11. Export Working Taglist To dialog box 

 
3. Enter a file name where the taglist will be stored in the File name dialog box.   

 
4. Click on the Save button. 

 
To retrieve a taglist that has been saved to a specific location: 
 

1. Click on the Taglist menu from the menu bar, and then select the Import command.  
 

2. The Import Taglist From dialog box will next appear.  Select an existing file from the 
desired directory or specify the name for the taglist.  If a different folder is desired, select 
one from the Look In drop-down menu.   

 
3. Click on the Open button. 

 
 
2.8   Extracting Data 

The ECB software generates SAS and SPSS programming code necessary to extract the variables 
listed in the working taglist from the project's data files.  The Extract menu on the menu bar 
accomplishes this task. 
 
The Extract menu has two options.  Selecting SAS will generate SAS program code to a file 
named by the analyst.  The *.sas extension will be automatically added.  Selecting SPSS will 
generate SPSS program code to a file named by the analyst, with the *.sps extension 
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automatically added.  Analysts will need SAS or SPSS software to run the extract programs.  
Reviewing an extract program before running it is recommended because it may need to be 
customized. 
 

2.8.1  Creating an Extract Program File 

To create an extract program file: 
 

1. Click on the Extract menu on the menu bar. 
 

2. Click on the statistical software package in which to create the extract program. 
 

3. The Save As dialog box will next appear (Figure 12).  Enter a file name for the extract 
program.  The appropriate extension (*.sas for SAS programs, *.sps for SPSS) will be added 
automatically.  Click on the Save button. 

 
 

 
Figure 12. Extract Save As dialog box 

 
4. If a file name that already exists is entered, a verification message box will appear (Figure 

13).  Click the Yes button to overwrite the existing file with the new file.  Click the No 
button to prompt the input of a new name under which to save the file. 
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Figure 13.  File already exists message box 

 
 

5. The Save Data File As dialog box will next appear (Figure 14).  Specify the name for the 
data file that will be created.  The extension (*.sd2 for SAS data sets, and *.sav for SPSS 
data sets) will be added automatically.  If a different folder for saved extract data files is 
desired, select one from the Save In drop-down menu.  A new folder can be created by 
clicking on the icon showing a folder with a star behind it. 

 

 
Figure 14. Save Data File As dialog box 

 
6. Enter a file name where the extracted data will be stored in the Save Data File As dialog 

box.  The default name for the data file is the name of the extract file.  If another name is 
desired, enter it in the file name text box. 

 
7. Click on the Save button. 
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2.8.2   Reviewing the Extract Program 

It is recommended to review the generated SAS or SPSS program code before running it.  Check 
that the line of code that defines the input data points to the data file's correct directory.   
 
Check also that the data subsetting statements are correct.  Code for generating frequencies and 
means are written in the program but "commented out."  Remove the comment symbols to obtain 
that output. 
 
It is easy to correct mistakes discovered after writing out or running the extract program if the 
working taglist was saved before exiting the ECB.  Simply restart the ECB, select the appropriate 
catalog, open the saved taglist, then go through the extract process again writing out a new extract 
program. 
 
 
2.9    Repair and Compact 

The ECB program utilizes a relational database that sits behind the ECB windows and contains 
the information for all the catalogs and their variables.  If many taglists are created and deleted on 
a regular basis, then the database will contain lingering references to old taglists that are no 
longer needed.  Repairing and compacting of files allows the ECB program to "clean house" and 
make the database more efficient.  It also decreases the size of the database, so space is 
conserved. 
 
To repair and compact files: 
 

1. Click on the Tools menu on the menu bar. 
 

2. Select Repair and Compact Database. 
 

3. The file repair and compact process will begin.  As it runs, the ECB program will display an 
hourglass figure. 

 
4. A confirmation message box will appear when the repair and compact process ends (Figure 

15).  Click the OK button to close the message box. 
 

 
Figure 15. Repair and compact message box 

 
 

  18



2.10   Switching Catalogs 

After completing work with one catalog, it is possible to access another catalog without quitting 
the ECB. 
 

1. Click on the File menu on the menu bar. 
 

2. Select the Open Catalog command.  If the working taglist has not been saved, a Save 
Changes message box will appear.  To save changes to the current working taglist, press the 
Yes button.  Otherwise, press the No button.  Pressing the Cancel button returns the Main 
ECB screen. 

 
3. The Select Catalog screen will reappear.  Choose another catalog with which to work and 

click OK. 
 
 
2.11   Exiting the ECB Program 

To exit the ECB program: 
 

1. Click on the File menu on the menu bar. 
 

2. Select the Exit command.  If the working taglist has not been saved, a Save Changes 
message box will appear.  To save changes to the current working taglist, press the Yes 
button.  Otherwise, press the No button.  Pressing the Cancel button returns the Main ECB 
screen. 

 
Clicking on the square X button in the top right-hand corner of the Main ECB screen will also 
exit the ECB program. 
 
 
2.12   A Sample ECB Session 

2.12.1  Selecting Variables for Analysis from the ECB 

The script below provides an example of a session with the TIMSS 2003 ECB software.  In this 
example, a user wants to create a file of variables associated with students’ mathematics 
achievement and time spent doing mathematics homework.  The actions the user would perform 
are shown below in italics. 
 
Select the TIMSS 2003 ECB by clicking the Start button and going to All Programs or double-
click on the TIMSS 2003 ECB icon on the computer desktop. 
 
The TIMSS 2003 ECB splash screen flashes on the computer screen.  The Select Catalog screen 
then appears. 
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Select the TIMSS 2003 Student Background File catalog and click OK or Double-click on the 
Student Background catalog in the Select Catalog screen. 
 
The variable list and initial working taglist associated with the TIMSS 2003 student background 
catalog appear on the screen.  The working taglist contains the variables required for all student 
catalog extracts. 
 
Click on the Narrow button in the Variable List window. 
 
Type the string HOMEWORK into the box, change the search option to Both Variable Name and 
Description, and click the Search button. 
 
Thirty variables appear dealing with homework.   
 
The user decides to further narrow the list by typing MATH into the Narrow dialog box. 
 
Two variables appear dealing exclusively with math homework. 
  
BSBMHWMG asks how many minutes the student spends specifically on math homework.  
BSDMHW is a derived index variable that measures the time a student spends doing math 
homework in three categories.  The user decides to add BSBMHWMG and BSDMHW to the 
taglist. 
 
Highlight the variables BSBMHWMG and BSDMHW by holding down the CNTL button and 
clicking on each variable.  Next, click on the right arrow button (>) on the bar between the 
Variable List and Working Taglist windows. 
 
The user knows that the student catalog also contains the plausible values variables for the 
mathematics achievement scores, but does not know the name of the variables.  The user decides 
to search for this variable on the student catalog’s variable list. 
 
Click on the Expand button in the Variable List window. 
 
Type the string PLAUSIBLE VALUE into the box, change the search option to Both Variable 
Name and Description, and click the Search button. 
 
The ECB now searches all variable names and labels for the string PLAUSIBLE VALUE.  Two 
sets of plausible value variables appear in the variable list.  These include the variables for the 
mathematics scores and the science scores.  Note that the narrowed variable list does not affect 
the working taglist. 
 
The user is interested in the plausible value scores for mathematics and adds these to the working 
tag list. 
 
Highlight the variables BSMMAT01 – BSMMAT05 in the Variable List window by pressing the 
Ctrl key and clicking on the variable names.  (An alternative way of selecting a sequential chain 
of variables is to hold down the SHIFT key, select the first variable and the last the variable.) 
 
Click on the right arrow button (>) on the bar between the Variable List and Working Taglist 
windows.  The five plausible value variables have been added to the working taglist. 
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The user decides not to add any other variables to the working taglist.  This set of variables, along 
with required variables initially in the taglist, will comprise the extract file.  Since this set of 
variables may be needed in future analyses, the user saves the current working taglist to a user-
defined taglist called HMWK_LIST. 
 
Click on the Taglist menu on the menu bar, and click on the Save As option. 
 
Type the new name HMWK_LIST into the Taglist Name box and click the Save button. 
 
 
 

2.12.2   SAS Extract Code Generation 

With the taglist saved, the user now wants to create an extract program from the taglist.  The 
program will contain SAS statements that will extract only the currently tagged variables.  The 
user wants to save these SAS program statements in a file named HMWK_MATH.SAS. 
 
Click on the Extract menu on the menu bar, and click on the SAS option. 
 
The Save As dialog box now appears. 
 
Type the new name HMWK_MATH into the File name box, select the directory where the file 
should be saved, then click the Save button. 
 
The SAS extract program will have the name HMWK_MATH.SAS in the specified directory.  
The Save Data File As dialog box now appears. 
 
Click the Save button in the Save Data File As dialog box. 
 
The SAS extract program will now create a SAS database called HMWK_MATH.SD2 that will 
store the variables the user selected in the working taglist. 
 
With the SAS extract program written and saved, the user can now quit the ECB and run the SAS 
statistical software package.  Using the program statements in HMWK_MATH.SAS, the software 
will extract a subset file of records and variables from the TIMSS 2003 national student data file.  
The user can also revise the SAS programming code to perform additional statistical analyses. 
 
To quit the ECB, click the File menu on the menu bar, then click on the Exit option. 
 
 
The user is now ready to run the extract code using the extracted variables from the ECB.  Below 
is the extract code in SAS. A few lines of the code require editing  before the extract program can 
be successfully run.  These code lines are shown in bold.  The required edits and explanations are 
indicated in italics below the code lines. 
 
libname LIB 'C: \'; 
 
The libname is assigned automatically by SAS with the directory path in which the program is 
saved.  The libname LIB may be changed to a different name if desired.   
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filename in1 'D:\bsgusan3.raw'; 
 
The filename line points to the path were where the ASCII student data file has been saved. This 
initial code is generated by the extract and may need to be changed to point to the directory that 
was specified when the data was saved from the self-extracting zip file on the CD-ROM. The 
default path would have been C:\TIMSS2003\data\.   If the default path was chosen, the filename 
code would become: 
 
filename in1 'C: \TIMSS2003\data\bsgusan3.raw'; 
 
 
footnote 'C: \HMWK_MATH.sas'; 
 
The footnote statement places the name and directory of the SAS program file on the bottom of 
each output page.  Printouts from the different files may look similar (like the math and science 
teacher files), and the footnote statement is a way to help the ECB user be clear about which file 
is being used.   
 
 
proc format;  
   value CTRY_F 
      840 = "United States" 
   ; 
   value IDPOP_F 
      1 = "TIMSS population 1" 
      2 = "TIMSS population 2" 
      3 = "TIMSS population 3" 
   ; 
   value TIME2_F 
      1 = "Fewer than 15 minutes" 
      2 = "15-30 minutes" 
      3 = "31-60 minutes" 
      4 = "61-90 minutes" 
      5 = "More than 90 minutes" 
      6 = "Missing" 
      8 = "Not administered" 
      9 = "Omitted" 
   ; 
   value JREP_F 
      0 = "Replicate group 0" 
      1 = "Replicate group 1" 
   ; 
   value HML_F 
      1 = "High" 
      2 = "Medium" 
      3 = "Low" 
      8 = "Not administered" 
      9 = "Omitted" 
   ; 
 
run; 
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data lib.HMWK_MATH; 
   infile in1 lrecl=954; 
      input  
   #1 
      @1 IDCNTRY  5. 
      @6 IDPOP    1. 
      @7 IDSCHOOL 4. 
      @11 IDCLASS  6. 
      @17 IDSTUD   8. 
      @169 BSBMHWMG 1. 
      @305 TOTWGT   13.6 
      @422 JKZONE   2. 
      @424 JKREP    1. 
      @461 BSMMAT01 6.2 
      @467 BSMMAT02 6.2 
      @473 BSMMAT03 6.2 
      @479 BSMMAT04 6.2 
      @485 BSMMAT05 6.2 
      @915 BSDMHW   1. 
      ; 
 
 
   label 
      IDCNTRY  = "*Country ID*" 
      IDPOP    = "*Population ID*" 
      IDSCHOOL = "*School ID*" 
      IDCLASS  = "*Class ID*" 
      IDSTUD   = "*Student ID*" 
      BSBMHWMG = "Mat\How Many Minutes Math Homework  Q18B" 
      TOTWGT   = "*Total Student Weight*" 
      JKZONE   = "*Jackknife Zone*" 
      JKREP    = "*Jackknife Replicate Code*" 
      BSMMAT01 = "*1st Plausible Value Mathematics*" 
      BSMMAT02 = "*2nd Plausible Value Mathematics*" 
      BSMMAT03 = "*3rd Plausible Value Mathematics*" 
      BSMMAT04 = "*4th Plausible Value Mathematics*" 
      BSMMAT05 = "*5th Plausible Value Mathematics*" 
      BSDMHW   = "Index of Time on Math Homework (TMH)" 
 
      ; /*format 
      IDCNTRY    CTRY_F. 
      BSDMHW     HML_F. 
      IDPOP      IDPOP_F. 
      JKREP      JREP_F. 
      BSBMHWMG   TIME2_F. 
      ; 
 */ 
 
To apply the formats defined in the PROC FORMAT statements the comment symbols (/*, */) 
above and below the format statement line should be removed. 
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run; 
 
/* 
proc contents; 
run; 
 
proc freq; 
table  
      IDCNTRY     
      IDPOP       
      BSBMHWMG    
      JKREP       
      BSDMHW      
; 
run; 
 
proc means; 
var  
      IDSCHOOL    
      IDCLASS     
      IDSTUD      
      TOTWGT      
      JKZONE      
      BSMMAT01    
      BSMMAT02    
      BSMMAT03    
      BSMMAT04    
      BSMMAT05    
; 
run; 
*/ 
 
As with the format line above, to run the PROC CONTENTS, PROC FREQ and PROC 
MEANS statements here, remove the comment symbols (/*, */). Options to these statements or 
additional PROC statements may be added if desired.  The SAS extract code is now ready to run. 

 
 

2.12.3   SPSS Code Generation 

Users can also create an SPSS extract program.  The program will contain SPSS statements that 
will extract only the currently tagged variables.  The user wants to save these SPSS program 
statements in a file named HMWK_MATH.SPS. 
 
Click on the Extract menu on the menu bar, and click on the SPSS option. 
 
The Save As dialog box now appears. 
 
Type the new name HMWK_MATH into the File name box, select the directory where the file 
should be saved, then click the Save button. 
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The SPSS extract program will have the name HMWK_MATH.SPS in the specified directory.  
The Save Data File As dialog box now appears. 
 
Click the Save button in the Save Data File As dialog box. 
 
The SPSS extract program will now create a SPSS database called HMWK_MATH.SAV that 
will store the variables the user selected in the working taglist. 
 
With the SPSS extract program written and saved, the user can now quit the ECB and run the 
SPSS statistical software package.  Using the program statements in HMWK_MATH.SPS, the 
software will extract a subset file of records and variables from the TIMSS 2003 national student 
data file.  The user can also revise the SPSS programming code to perform additional statistical 
analyses. 
 
To quit the ECB, click the File menu on the menu bar, then click on the Exit option. 
 
The user is now ready to run the extract code using the extracted variables from the ECB.  Below 
is the extract code in SPSS. A few lines of the code require editing before the extract program can 
be successfully run.  These code lines are shown in bold.  The required edits and explanations are 
indicated in italics below the code lines. 
 
* 
* C:\HMWK_MATH.sps 
* 
* SPSS program to create extract file 
* 
SET MORE=OFF/SCREEN=OFF. 
FILE HANDLE FHAND /NAME='D:\bsgusan3.raw' /LRECL=954. 
 
The FILE HANDLE line points to the path were where the ASCII student data file has been 
saved. This initial code is  generated by the extract and needs to be changed to point to the 
directory specified when the data was saved from the self-extracting zip file on the CD-ROM. The 
default path would have been C:\TIMSS2003\data\.   If the default path was chosen, the filename 
code would become: 
 
FILE HANDLE FHAND /NAME='C:\TIMSS2003\data\bsgusan3.raw' /LRECL=954. 
 
 
DATA LIST FILE=FHAND TABLE 
/1 
   IDCNTRY  1-5 
   IDPOP    6-6 
   IDSCHOOL 7-10 
   IDCLASS  11-16 
   IDSTUD   17-24 
   BSBMHWMG 169-169 
   TOTWGT   305-317  (6) 
   JKZONE   422-423 
   JKREP    424-424 
   BSMMAT01 461-466  (2) 
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   BSMMAT02 467-472  (2) 
   BSMMAT03 473-478  (2) 
   BSMMAT04 479-484  (2) 
   BSMMAT05 485-490  (2) 
   BSDMHW   915-915 
 
 
   VARIABLE LABEL 
      IDCNTRY         "*Country ID*" 
      IDPOP           "*Population ID*" 
      IDSCHOOL        "*School ID*" 
      IDCLASS         "*Class ID*" 
      IDSTUD          "*Student ID*" 
      BSBMHWMG        "Mat\How Many Minutes Math Homework  Q18B" 
      TOTWGT          "*Total Student Weight*" 
      JKZONE          "*Jackknife Zone*" 
      JKREP           "*Jackknife Replicate Code*" 
      BSMMAT01        "*1st Plausible Value Mathematics*" 
      BSMMAT02        "*2nd Plausible Value Mathematics*" 
      BSMMAT03        "*3rd Plausible Value Mathematics*" 
      BSMMAT04        "*4th Plausible Value Mathematics*" 
      BSMMAT05        "*5th Plausible Value Mathematics*" 
      BSDMHW          "Index of Time on Math Homework (TMH)" 
      . 
 
VALUE LABELS  
   / IDCNTRY  
      840  "United States" 
   / IDPOP    
      1  "TIMSS population 1" 
      2  "TIMSS population 2" 
      3  "TIMSS population 3" 
   / BSBMHWMG 
      1  "Fewer than 15 minutes" 
      2  "15-30 minutes" 
      3  "31-60 minutes" 
      4  "61-90 minutes" 
      5  "More than 90 minutes" 
      6  "Missing" 
      8  "Not administered" 
      9  "Omitted" 
   / JKREP    
      0  "Replicate group 0" 
      1  "Replicate group 1" 
   / BSDMHW   
      1  "High" 
      2  "Medium" 
      3  "Low" 
      8  "Not administered" 
      9  "Omitted" 
   . 
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SAVE OUTFILE =  'C:\HMWK_MATH.sav'. 
 
This line writes out an SPSS data set that will be generated by the extract program.  The default 
path for this data set is the location of the extract program.  This may be changed as desired, for 
example, it may be that an SPSS folder has been created.  The new code would be: 
 
SAVE OUTFILE= 'C:\TIMSS 2003\SPSS\HMWK_MATH.SAV' . 
 
DISPLAY DICTIONARY. 
 
* Frequencies /Variables =  
      IDCNTRY     
      IDPOP       
      BSBMHWMG    
      JKREP       
      BSDMHW      
/MISSING=INCLUDE. 
 
* Descriptive VARIABLES= 
      IDSCHOOL    
      IDCLASS     
      IDSTUD      
      TOTWGT      
      JKZONE      
      BSMMAT01    
      BSMMAT02    
      BSMMAT03    
      BSMMAT04    
      BSMMAT05    
. 
 
 
The symbol ‘*’ in front of the Frequencies and Descriptive statements comments these 
statements out.  This symbol needs to be removed from these lines.  The SPSS extract code is now 
ready to run.   
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3.  Electronic Codebook (ECB) Troubleshooting Guide 

 
 
What hardware and software requirements are needed to run the ECB software? 
 
The Electronic Codebook (ECB) software is designed to run under Windows 95, Windows 98, 
Windows 2000 and Windows XP.  The ECB alone, without the data files, requires approximately 
18 MB (megabytes or million bytes) of available disk space on the hard drive.  After being 
installed, the ECB can create and save personal taglists.  These taglists will require minimal disk 
space.  The ECB can also create SAS, and SPSS for Windows; these extract programs will 
require little disk space. 
 
 
How do I uninstall/reinstall the ECB software from my computer? 
 
Depending on the configuration of the computer it may be necessary to remove the software by 
finding the ECB setup executable in a subdirectory on the local disc.  This will be located in 
C:\Program Files\InstallShield Installation Information.  Within this subdirectory there will 
be a folder containing configuration settings and additional files as well as the setup executable.   
If the user has installed multiple ECBs there will be one folder for each ECB.  The user can 
determine which folder is assigned to the ECB of interest by double clicking the Setup.exe file.  
Once this is determined, the user can remove the ECB by following the prompts.  This process 
may automatically restart the computer.  The ECB may be reinstalled from the CD-ROM at any 
time.     
 
 
Why are the ECB window screens so hard to read?  Why are the windows too small (large)? 
 
The ECB program fits best visually on screens set to a desktop area of 800 x 600 pixels.  It will 
still work on other screen settings, but it may not make the best use of the available screen space.  
To check and/or set your desktop area, follow these steps: 
 
1. Click on the Start button. 
 
2. Select Settings, Control Panel, and then Display. 
 
3. Select the Settings tab. 
 
4. Set the Desktop Area to 800 x 600 with the Desktop Area slidebar. 
 
 
What do I need to run the extract programs generated by the ECB software? 
 
The extract programs provide the SAS/SPSS code to generate SAS data sets or SPSS system files 
containing the variables of interest to the user. The ECB does not create a SAS or SPSS data file.  
It simply prepares the statements that can be used with these statistical software packages to 
create those files.  The user must run the extract code in SAS/SPSS to create a SAS data set or 
SPSS system file. 
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Why can I not delete some variables from the working taglist? 
 
A catalog may contain one or more "required variables."  Required variables are deemed 
necessary for any analysis of that catalog's data, and they will be automatically included in all 
extracts.  Examples of required variables are identification variables, such as the student or school 
id, and sampling variables such as weights or replicate weight variables. If a required variable is 
selected for removal from the working taglist, an error message box will appear.  Click the OK 
button to remove the message box. 
 
 
How many user defined taglists can you save for each catalog? 
 
Each catalog can have an unlimited number of saved user defined taglists, dependent only upon 
the memory limitations of the hard drive.  If many taglists are created and deleted on a regular 
basis, then the user should periodically repair and compact the Microsoft Access database the 
ECB program uses for all the catalogs.  Taglist creation and deletion will lead to the database 
containing lingering references to old taglists that are no longer needed.  Repairing and 
compacting files allows the ECB program to "clean house" and make the database more efficient.  
It also decreases the size of the database, so space is conserved. 
 
 
For certain variables, why does the codebook list erroneous or nonsensical values in the 
Codes column? 
 
Printing limitations may cause what looks to be erroneous or nonsensical data printed in the 
Codes column of the codebook.  The ECB program uses the Crystal Reports report generation 
software to produce its codebooks.  The codebook's printed format follows a layout designed in 
the Crystal Reports software.  In the current codebook layout, the Codes column lists the actual 
value - or range of values - of a variable associated with the response category, which is listed in 
the Response column.  Data for this column comes from the Format Value field in the Format 
Master table of the Microsoft Access database used by the ECB program.  The Codes column has 
a maximum length of 12 characters.  If the value(s) listed in the Format Value field take up more 
than 12 characters, then the Codes column only displays the last 12 characters of the field.  It is 
possible, but not likely, that similar printing errors could occur in other fields and columns listed 
in the codebook.  Future versions of the ECB software may contain a revised Crystal Reports 
codebook layout that increases the size of the Codes column. 
 
 
Why can I not do cross tabulations of two or more catalog variables in a codebook? 
 
The ECB does not actually calculate either the frequencies or percentages of variables listed in a 
codebook.  Those unweighted values are stored in the Frequency Master table within the project's 
Microsoft Access database read by the ECB program.  Once a variable is tagged for a codebook, 
the ECB program searches the Access database tables, including the Frequency Master table, to 
collect the codebook data for that variable.  The data is then entered into a Crystal Reports report 
format to produce the codebook. 
 
 

  29



 
 
Why limit the choices of codebook export files? 
 
An exported codebook can be saved in one of the three following formats:  Crystal Reports, Rich 
Text Format, and Word for Windows.  For other formats (like Excel, WordPerfect, etc.), save the 
exported codebook with Rich Text Format.  Rich Text Format saves all format commands in the 
codebook and converts it to instructions that other programs, including Microsoft compatible 
programs, can read and interpret.  Future versions of the ECB software may include additional 
options for codebook export files. 
 
 
Can I subset a catalog on variables not listed on the Extract Specifications screen? 
 
Not while generating an extract program.  The ECB program utilizes a Microsoft Access database 
to store information about each catalog and its variables.  Within the database, the Variable 
Master table lists which variables can be used to subset each catalog.  If one of those variables 
appears on the working taglist, then it will appear on the Extract Specifications screen.  If the 
variable in question is not marked as a subsetting variable in the Variable Master table, then that 
variable will never appear on the Extract Specifications screen. 
 
It is possible to extract a subset of catalog records based on a variable not found on the Extract 
Specifications screen.  Create an extract program from a working list that includes the subset 
variable.  Before running the extract program, modify the programming code to include that 
variable in the subsetting commands.  Use the values listed in the Codes column of that variable 
from the codebook to determine how to subset the catalog. 
 
 
What if the ECB-generated extract programs do not run properly? 
 
Review the generated SAS or SPSS program code before running it.  The programs assume that 
the project data files used by the extraction program will be found on the local c:\ drive.  If the 
project data files are in another location (extended path on the local hard drive, network drive, 
etc.), change the code that specifies where the project data file is located.  At the top of the SAS 
program, edit the line that defines the filename.  An example of that SAS line of code follows: 
 
filename in1 'C:\bsgusan3.raw'; 
 
At the top of the SPSS program, edit the line that assigns the handle FHAND to the input data set.  
An example of that SPSS line of code follows: 
 
FILE HANDLE FHAND /NAME='D:\ bsgusan3.raw' /LRECL=954. 
 
For each case, replace the directory listed in the specified line of code ("D:\data file name" in the 
examples above) with the correct data directory where the data has been saved from the CD-
ROM. 
 
When reviewing the extract programs, check also that any statements subsetting the data are 
correct.  Code for generating frequencies and means are written in the program but "commented 
out."  Remove the comment symbols to obtain that output. 
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4.  Electronic Codebook (ECB) Glossary 

 
Cancel  A command button found in several windows and screens.  Closes the current screen or 
window. 
 
Catalog  An ECB data file, usually corresponding with a project data file.  Each catalog has a 
variable list and one or more predefined taglists. 
 
Codebook  (1) A detailed variable listing that can be either viewed or printed.  Information 
displayed in a codebook includes variable name, variable label, any question number and wording 
associated with the variable, the record number, position, and format of the variable on the data 
file, and any comment fields.  It also displays response categories, unweighted and weighted 
frequencies, and unweighted and weighted percentage distributions.  (2) A menu listed on the 
menu bar that allows users to view and print codebooks.  
 
Continuous Variable  A catalog variable with an infinite number of possible values.  Within a 
codebook or extract file, the response categories of continuous variables are represented by 
ranges of values. 
 
Discrete Variable  A catalog variable with a finite number of possible values.  Within a 
codebook or extract file, the response categories of discrete variables are represented either by 
single values or ranges of values. 
 
ECB  Electronic Codebook.  A software package that allows analysts a simple computerized 
interface to examine variables within a project's data files (called catalogs). 
 
Expand  A command button in the Variable List window.  Adds to the current variable list any 
variables for the catalog whose name and/or description contains a specified keyword. 
 
Export  A command button in the View Codebook screen.  Creates a copy of the codebook as 
either a Crystal Reports file, Microsoft Word file, or a rich text format (RTF) text file. 
 
Extract  (1) A subset of records and/or variables within a catalog.  (2)  A menu listed on the 
menu bar that allows users to create a statistical program (SAS, SPSS, STATA) that will pull out 
a defined subset of records and variables from a catalog. 
 
Extract Program  A software program that creates an extract from a catalog.  The ECB software 
package can create an extract program for the SAS, SPSS, or STATA statistical software 
packages. 
 
Extract Specifications  A blueprint of what variables and/or records to choose for an extract.  
The Working Taglist defines which variables will appear in the extract, while the Extract 
Specifications screen limits the number of records in an extract based on selected response 
categories within subsetting variables. 
 
File  A menu listed on the menu bar that allows users to open a catalog, define the printer 
settings, or exit the ECB software. 
 
Frequency  The number of times the value(s) of a variable appears within a catalog. 
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Help  A menu listed on the menu bar that calls up the ECB software's electronic help file. 
 
Menu Bar  The bar that lies underneath the title bar on the main ECB screen.  The menu bar 
contains a series of pull-down menus (e.g., File, Taglist, Extract, Tools, Codebook, and Help).  
Selecting items from the pull-down menus provide access to the action commands available in the 
ECB. 
 
Narrow  A command button in the Variable List window.  Keeps only those variables in the 
current variable list whose name and/or description contains a specified keyword. 
 
Percentage  A relative measure of how often the value(s) of a variable appears within a catalog 
as compared to all values of that variable. 
 
Predefined Taglist  A saved list of catalog variables that came with the original ECB software 
package. was created in an earlier ECB session, or was created and saved earlier in the current 
ECB session. 
 
Print  A command button in the View Codebook screen.  Sends a copy of the codebook to a 
printer connected to the computer running the ECB software. 
 
Repair/Compact  An option under the Tools menu on the menu bar.  Eliminates lingering 
references to deleted taglists within a catalog, which also decreases the size of the database. 
 
Reset  A command button in the Variable List window.  Restores all of the variables within a 
catalog to the current variable list. 
 
Response Category  A possible value, or set of possible values, for a catalog variable, as defined 
by the ECB software.  For continuous variables, which have an infinite set of possible values, a 
category will list a range of values.  For discrete variables, which have a finite set of possible 
values, a category most likely will represent a single value, but it can also represent a range of 
values. 
 
SAS  One of three software statistical packages in which the ECB software creates extract 
programs.  A SAS extract program will have an *.sas extension. 
 
Save  A common button in the Working Taglist window.  Stores the working taglist as a user 
defined taglist. 
 
SPSS  One of three software statistical packages in which the ECB software creates extract 
programs.  An SPSS for Windows extract program will have an *.sps extension. 
 
Tagged Variable  A variable on either the variable list or the working taglist that has been 
"tagged," i.e. either highlighted or clicked. 
 
Taglist  (1) A list of data file variables.  Taglists can be one of three types:  predefined taglists 
(saved lists of variables that came with the ECB), user defined taglists (saved lists of variables 
created by users), and working taglists (the current list of variables defined on the main ECB 
screen).  (2) A menu listed on the menu bar that allows a user to manipulate the current working 
taglist. 
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Title Bar  The horizontal bar located at the top of the main ECB screen.  It gives the name of the 
application (ECB for Windows) and the catalog in use. 
 
User Defined Taglist  A saved list of catalog variables created by a user in an earlier session, or 
created and saved earlier in the current ECB session. 
 
Variable List  The window that forms the left half of the main ECB screen.  It shows all of the 
variables listed within a catalog, as manipulated by the Narrow, Expand, and Reset command 
buttons. 
 
Weighted Frequency  The number of times the value(s) of a variable appears within a catalog, as 
defined by the weights assigned to the data file records. 
 
Weighted Percentage A relative measure of how often the value(s) of a variable appears within a 
catalog as compared to all values of that variable, as defined by the weights assigned to the data 
file records. 
 
Working Taglist  The window that forms the right half of the main ECB screen.  It shows the 
current catalog variables selected for creating either a codebook or an extract program. 
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